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8.1 Scope of Protocol

MPs, defined as plastic particles sized 0.1 pm - 5 mm (Hartmann et al., 2019), are an issue of
concern because of their ubiquity in the marine environment, caused by worldwide plastic
manufacturing and inadequate waste management. The broad distribution of these global
contaminants (2008/56/EC Marine Strategy Framework Directive, Descriptor 10; United
Nations Sustainable Development Goal 14 target 14.1.1 [Gigliotti et al., 2019]) has been
confirmed in numerous research studies, going from surface waters to the bottom of the
ocean and covering all depths, and from Arctic waters to Antarctic waters, including coastal,
open and deep sea waters (Zhang, 2017; Pakhomova et al., 2022). Moreover, growing
empirical data point to potential adverse effects on organisms after ingestion (Franzellitti et
al., 2019). Risk assessment evaluations are needed to comprehend the consequences of
MPs on an individual, population, and ecosystem level as well as on human health, and for
this, credible MP monitoring data is crucial. Despite recent advancement and diversification
of MP analysis techniques, which can provide information on biota exposure to MPs, many
approaches are seen as being costly and time-consuming. Furthermore, the multitude of
unsolved concerns regarding MP abundance, composition, distribution, fate, and effects in
the marine environment highlight the need for more accessible, standardised and reliable

analysis techniques.

The JPI Oceans-funded ANDROMEDA project is a multidisciplinary collaboration of 15
international partners focused on improving the quantification of NPs and MPs in our oceans
and seas. Within the project, new sampling and advanced analysis methodologies that focus
on smaller MP (< 10 pm) and NP (< 0.2um) particles have been developed, which will enable
a more accurate assessment of risks associated with plastic pollution. Novel sampling
techniques as well as cost- effective MPs measurements methods have been developed for
a more efficient and effective MP monitoring. As a result, a series of protocols related to MPs
extraction, analysis and degradation were developed and optimized, and used by project

partners. They are now made available to the plastic research community as SOPs.

This particular protocol focuses on the semi-automated, cost-effective MP analysis based on
machine learning and RGB colour quantification of Nile red stained fluorescent particles.
The developed, optimized (Meyers et al., 2022) random forest (RF) models were tested for
MPs down to 3 um and proved accurate for their detection and the identification of their
polymer types. The models demonstrated their ability to analyse pristine MPs in various
marine matrices, artificially deep sea- and surface-weathered MPs, and ultimately MPs in real

marine environmental samples.
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8.2 Materials and Equipment

A. Computer with sufficient storage capacity or access to a cloud storage service, and
the open-source programmes ImagedJ Fiji, R and R studio installed:
o Download ImagelJ Fiji (https://imagej.net/software/fiji/downloads)
o Download R or R Studio (https://cran.rstudio.com)

B. ImageJ scripts and R codes to create random forest models:
https://github.com/NelleMeyers/RGB_models

C. Unprocessed PTFE membrane filter (10 um, @ 47 mm)
D. Fluorescence microscope (FM) or fluorescence stereomicroscope (FSM)
o Fluorescence stereomicroscope: e.g. Leica M205 FA Fluorescence

stereomicroscope
o Software: LAS X software

Table 1: Setting specifications LAS X software for a Leica M205 FA Fluorescence stereomicroscope

Filter Exposure

e Bluefilter- 10447407 Filter set 8.87s
ET GFP LP M205FA/M165FC

e  Greenfilter- 10450198 Filter 78.01ms
set ET CY3 M205FA/M165FC
ET545

e UVfilter- 10450609 Filter set 8.87 s
ET UV LP M205FA/M165FC

Climate control

E. Fluorescence microscope: e.g. LEICA DM 1000 fluorescence microscope
o Equipped with a camera and a LED for fluorescence

o Software: LAS Core software (Leica Application Suite version 4.13.0)
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Table 2: Setting specifications LAS Core software for a LEICA DM 1000 fluorescence microscope

Filter Exposure
o Blue filter: filter System 13 S, BP 2.91 ms
450-490 nm
e Green filter: filter system N2.1S, 1.01 ms
BP 515-560 nm
e UV filter: filter System A'S, BP) 26 ms
340-380 nm

8.3 Protocol

For the sake of clarity, all folders mentioned in this protocol will be in green, all codes in red,
all images in blue, all generated Excel files in purple and all working directories or lines of

code in grey.

8.3.1 Particle Selection

To create the predictive models, two separate datasets are needed: one to train the Plastic
Detection Model (PDM) to allow for plastic detection, and one to train the Polymer
Identification Model (PIM) to allow for polymer identification of plastics. Before image
acquisition and analysis, determine the type of particles you want to incorporate in your
dataset, and perform a power analysis to know the required size of your training dataset. The
size of the dataset will depend on the required statistical power, which depends on the
chosen significance level a; the effect size; and the number of different categories

(plastic/non-plastic for the PDM; different polymer types for the PIM).

To create a PDM dataset, photos of fluorescently dyed organic particles representative of the
marine environment should be acquired. For example, chitin, cotton, flax, hemp, silk, wood
and wool can be used to do so (Meyers et al., 2022). Furthermore, particle size should be
representative of MP sizes observed in the marine environment. To obtain small particle sizes,

plastics can e.g., be cryo-milled using a cryogenic grinder.
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For the plastic particles within both datasets (PDM and PIM), polymer types commonly
observed in marine environmental samples should be selected (Suaria et al., 2020). Moreover,
ensure a broad range of densities is covered. For example, seven of the most abundant
produced plastic polymers worldwide could be included (Geyer et al, 2017): nylon,
polyethylene (PE), polyethylene terephthalate (PET), polypropylene (PP), polystyrene (PS),
polyurethane (PUR) and polyvinyl chloride (PVC). It is strongly advised during the model
training phase to use one polymer type per PTFE filter, to avoid additional p-FTIR analyses of
particles, and to allow for rapid image analysis as well as RGB dataset construction. The best
practice to ensure model robustness is to use plastics from different manufacturers, as well as
multiple PTFE filters per polymer type, to incorporate potential associated variation in

fluorescence colouration.

To determine the dataset size needed to train a RF model, the required significance level a,

the effect size d (Cohen, 1988) and the number of categories should be considered.

To create the models, particles should be stained as described in Meyers et al., 2024 (a, b,
and c). They can be spiked in and recovered from a matrix (seawater, sediment or biota) using
the SOPs, with subsequent staining with the fluorescent dye Nile red, or they can be spiked
in Milli-Q water and stained with Nile red directly after without performing a sample
processing step. For subsequent analysis, particles should be extracted from marine samples
as described in Meyers et al., 2024 (a, b and ¢).

8.3.2 Image Acquisition

A. Always take photos of the same particle(s) in the same frame in all the settings,
making sure the stage does not move and you do not switch to a different
magnification. For setting specifications for a Leica M205 FA fluorescence
stereomicroscope and a LEICA DM 1000 fluorescence microscope, see Table 1 and

2, respectively.

B. Each photo series of a particle/number of particles consists of three photos: a photo
acquired under a blue filter, under a green filter and under a UV filter. If possible, a
bright field photo (no filter) should be acquired as well. For further photo

acquisition details, see Section 8.2 'Materials and equipment'.

C. All photos should be saved in “TIFF” format. Store them under the ‘Photos’ folder.
If taken, bright field photos should be stored in the sample folder (and not under
'Photos’). Generated CSV files will be saved under the 'RGB’ folder after photo
analysis in ImageJ.
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D. Using the LAS software to acquire photos, label each photo with a unique code.
For each photographed filter area, a series of three images is required, taken under
the blue, green and UV filter. Generated CSV files of each photo will be saved under
'RGB’ after photo analysis in ImageJ. For the code to run correctly, Photos should

be named as followed, in capital letters:

‘name of the filter’ +_+ ‘number’ +_+ ‘colour
For example: PET_1_BLUE’; ’PET_1_GREEN’, and ’PET_1_UV’

In the following example, the construction of an RGB dataset to create a PDM is described,
using the script where batch mode is not used. To create a dataset for a PIM, the same
procedure should be followed, with the exception that photographs of different plastic

polymer particles will be analysed, rather than plastic and organic particles.

8.3.3 Creating Machine Learning Models

8.3.3.1 File Organisation

Create a folder called ‘Automated MP_analysis', and four subfolders called ‘Coding’,
‘Model constructions’, "Training_datasets’, and '"Model visualisations’. Save the ImageJ code
('RGB_extraction_batchmode’ or 'RGB_extraction_nobatchmode’) and the two R scripts
('/RGB_dataset’ and 'PDM_PIM’) under ‘Coding’. Next, classify your sample images:

1. Batch mode (FM - multiple photos/PTFE filter)
Create three subfolders within ‘Model_constructions”: ‘Photos’, 'Metadata’ and 'RGB'.

Store all images (blue, green, uv) within ‘Photos’.

2. No batch mode (FSM - 1 photo/PTFE filter)
Create subfolders per photographed PTFE filter within ‘Model_constructions’.

Within these filter-specific folders, each time create three distinct folders: 'Photos’,
'‘Metadata’ and 'RGB'. Store all filter-specific images (blue, green, UV) within
'‘Photos’.

8.3.3.2 ImagelJ

e Openlmaged Fiji.
e Open a new macro through 'Plugins’ > ‘New’ > ‘Macro’'.
e Paste the ImageJ script 'RGB_extraction_batchmode’ or

'RGB_extraction_nobatchmode’ in the new window

74



Macros »
Shortcuts »
Utiities

[ (Fijils Just) Image)

Fle EGt Image Process Analyze Compie andRun. Macro Tool
ool oV £t R A stal Curi+ShitsM | JavaScript
“Sraight', segmentad or freshand lines, or o _I1St2N Plugin Plugin
30 Viewer Plugin Filter
Analyze »| Plugin Frame !
BigDataViewer | Piugin Tool le EQt Langusge Templates Run Tools Tabs
£98 Loeoveie,,
. » 3 "Macrojmim | New_
Bio-Formats m—— y
Cluster

Opuons.

Color Inspector 30
Examples. »
Excel ToolBar.

Feature Extraction »
HOF5

Image5D

Integral image Filters

Janelia H265 Reader

Noise

Loci »
LSM Toolbox »
Landmarks »

noiseradius
minParticle

Multview Reconstruction  *
NeuroAnatomy
Optic Flow

Process

(/SPECIFICATION OF THE RADIUS

SPIM Registration

Segmentation

Skeleton

Stacks > oot
Stitching »

»
»

Registration » a-—
»
,
,

persistent

ShowErrors | Clear | B

Figure 1: Open script in imageJ

Setting the Correct Scale

Start by setting the correct scale. To do so, use
a bright field photo of an unprocessed PTFE
filter, acquired with the exact same microscope
specifications used for the bright field photo of
the actual sample. Open the photo ('File’ >
‘Open’) and use the line-selection tool to draw
the diameter of the PTFE filter (see Figure 2).
Next, set the scale (‘Analyse’ > 'Set scale’), enter
the known length of the filter diameter under
‘Known distance’ in ym (47000), enter ‘um’ as
unit of length, and make sure ‘Global’ is checked
so that the same scaling factor is used for all
photos while the program is opened. Once
it best the

corresponding number of pixels per um, in case

scaled, is to note down

rescaling would be necessary in the future.

Once this is done, press ‘OK’, and close the photo.

B Empt for_scaling
62573.79x54620.26 um (10739x3374); RGB: 384M8

(&) set Scale

Distance in pucels: [8078.4791
Known distance: 47000
Pixel aspectratio: [1.000
Unitoflength: [om

Clickto Remove Scale

¥ Global|

Scale. 0.1719 pixelsiym

OK | Cancel | Help

Figure 2: Setting the correct scale
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B. Extraction of RGB value
Open the blue filter photo (‘File’ >
‘Open’) in ImageJ followed by the

green filter and lastly the UV filter (in

this specific order) (see Figure 3). Run
the macro ‘Run’ > ‘Run’. Uncheck the
'‘Disable Global calibration’ box (and
check 'Disable these Messages’) to
make sure the scaling from the
unprocessed PTFE filter is used to
scale the photos. Select the 'RGB’

folder you just created as a

destination directory to store the CSV Figure 3: Open the three pictures (blue, green and
files with extracted RGB values (dialog box). UV filter) in imageJ, and run the macro

C. A new dialog box pops up. Specify

the noise radius the program should

use (i.e. from what number of pixels

onward a selected area should be
considered a particle rather than
noise) (see Figure 4) Next, specify the
minimum size of the recognised

particles for which the RGB values of

the pixels on the maximum Feret

diameter should be extracted. Enter

for example ‘10" in both fields, then

Figure 4: Specify the noise radius and min. particle
press ‘OK". size for which RGB values should be extracted

D. For the next step, an option is for the program to recognize overlapping particles and split

them into separate particles.

Note: If the exact number of particles present is important and the number of overlapping
particles is high, it is advised to choose 'no’, as unique particles are sometimes mistakenly

splitinto multiple particles.
E. The program asks for the scale to be set. The scale was already specified prior to this step,

but to verify the accuracy, the diameter of the filter can be drawn using the line-selection

tool (e.g. on the UV photo as borders are clearly visible).
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Next, press '‘OK'. The length

shown under ‘'known distance’

should now approximate the

diameter of the reference PTFE
filter, which is 47000 pm. As
circularity of the current filters is

not a 100%, the value will deviate

slightly from the set value. Don't
make any changes, but make sure
the 'Global" box is still checked
(see Figure 5).

Figure 5: Test whether the scale has been set

The blue filter photo will be processed

(the first opened photo). First, a
threshold needs to be set to identify all
particles present (see Figure 6). To do
so, move the upper slider bar until all
particles are red. Make sure this specific
window is selected, otherwise no
changes will be observed when

adjusting the slider bar. Next, press

‘Apply’. Now, all selected red particles
turn white. Following this, press‘Ok’. Itis
important to respect the order of pressing ‘Apply’ first Figure 6: Set the correct threshold

followed by ‘ok’, and not the other way around.

. Subsequently, all particles will be

selected in yellow on the original

photos. The progress here can be
observed in the menu bar. ‘Do you want
to move the ROIs (Regions of Interest)

for the next picture? pops up, choose
p pops up

‘'yes' for this question (see Figure 7).

Figure 7: The ROIs are now visible on the original

photos
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H. Once the program is ready, all particles will be selected in blue. Select the line selection tool if
not selected, put the cursor on a particle, click right and keep it pressed down to move the

whole particle selection until the particle outlines match with the particles (see Figure 8).

o3 )
50232.91x43725.21 pm (10768x9373). RGB; 385MB 50232 21 ym (10768x9373); ROB: 385M8

USERINPUT: Manual

Move ROIs if needed

Figure 8: Move to ROls to the correct position if necessary

It is advised to zoom in while doing so. Next, press ‘Ok’. Following this, RGB values files will be

generated for all particles on the blue filter.

Note: If the selection would turn yellow, it can no longer be moved. If this happens, go to the
‘ROl manager’ window and click on the number, which represent the selection. Following this,
the selection should turn blue again. Next, choose 'Yes’ when ‘Do you want to move the ROls
for the next picture? pops up again, this time for the green filter photo. Move the selection if
needed, so that all particles are correctly outlined, then press 'Ok’ for ‘"Move ROlIs if needed'.

Repeat the same process for the UV filter.

When using the batch mode script, the next series of three photos of a sample (photographed
under a blue, green and UV filter) will open, after which the threshold process and extraction
of RGB values will be repeated. This process will be repeated until all photos stored in that

folder are processed.

8.3.3.4 RStudio

Calculation of RGB-Statistics

A. Go to the folder 'RGB’ of a specific sample a check whether files have been generated.

o 'Numbered_particles_1.tif', 'numbered_particles_2.tif, and numbered_particles_3.tif" are

the blue, green and UV filter photos with numbered particles (see Figures 9a, b and ¢),
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respectively. 'PET 4 _numbered particles.tif is black-white outline of all analyzed
particles, here particles are also numbered (see Figure 9d). When opening the metadata
file ‘particle_measurements_4_details.xI', In column ‘A’ the particles numbers can be
found  which  correspond  with  the  numbered particles  in  the
'PET_4_numbered_particles.tif photo. Notice however that this numbering does not
correspond with the numbering on the ‘'numbered _particles’ photos. In column ‘E’, the
size (maximum Feret diameter) of the corresponding particles can be found. More

particle characteristics can be found in other columns.

For every particle on the three 'numbered _particles’ photos’, a CSV file per colour filter
can be found: e.g. for particle 1, a file 'PET_BLUE p1.tif, 'PET_GREEN p1.tif and
'PET_UV_p1.tif’ can be found.

These files contain RGB data for each pixel located on the maximum Feret diameter of a
selected particle. In the file, each row presents a pixel, where 'X,Y, Red, Green, Blue' stand
for the x-coordinate, the y-coordinate as well as the red (R), green (G) and blue (B) value

(all ranging between 0-255) of that pixel, respectively.

Note: For the script with batch mode, all numbered colour filters photos as well as all
CSV files can be found in the same RGB folder.

Figure 9: LRTB: ‘'numbered_particles’ for the blue (a), green (b) and (c)
UV filter, with all particles numbered, as well as a (d) black-white outline.
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B. Open the 'RGB_dataset’ scriptin R. In this step, the mean, median, 10th and 90 percentiles of
the RGB value of all analysed pixels belonging to a particle (= per CSV file) will be calculated
in R. As a first step, create three new folders within your RGB folder: ‘BLUE’, 'GREEN" and ‘UV'.
Next, copy all '_BLUE'-CSV files into the BLUE folder, all _GREEN'-CSV files into the GREEN
folder, and all '_UV'-CSV files into the UV folder.

C. Once the R script is opened, adapt the working directory to the directory where the 'BLUE'-
CSV files are stored:

Change the working directory again for the Green CSV files:
setwd(".../Model_constructions /PET/RGB/GREEN”)

and do this once more for the UV CSV files further on in the script:
setwd(".../Model_constructions /PET/RGB/UV”)

Next, change the working directory to the location where the UV CSV files are
stored after ‘Export’: Export<-setwd(".../Model_constructions /PET/RGB/UV")

Lastly, choose a name for the generated dataset, e.g. 'PDM_RGBdataset".
Filename<- paste(Date," _PDM_RGBdataset'xIsx",sep="")

— After this, run the whole script. A dataset containing all particle statistics will be
generated in the UV folder.

D. Open the generated dataset and delete the first row ‘Fulldataset_bluefilter’. Following
this, select all statistics (column D until AM, row 3 until the end of the dataset), right click
on the selected data and select ‘Convert to number'. Lastly, adapt all cells so that the
values have 0 decimals. Right now, the dataset with RGB statistics of photographed
particles is ready. Each line in the Excel file now contains RGB statistics of an analyzed
particle which can be traced back on the analysed photos through its number. As a last
step, save the dataset with RGB statistics (e.g. as 'PDM_RGBdataset.xIsx’) under the

folder ‘training datasets’.

E. If desired, a RGB dataset for a PIM can be constructed as a next step, containing RGB

statistics of different plastic polymers.

8.3.3.5 ML Model Construction

A. Openthe code 'PDM_PIM'"in R.
o Adapt the working directory to where the newly generated datasets are stored:

80



setwd(".../Model_constructions /Training_datasets”)

o Choose a name for the decision tree plot of the generated RF model, e.g.
'PDM_setseed?': jpeg(file = "Model_visualisations/PDM_setseed?7.jpg")

B. Run the script under ‘#Generate model’. A random forest model will be generated

following randomization of the training dataset. A total of 1000 bootstrap decision
trees will be generated (ntree = 1000) (see Figure 10), where all 36 variables are
randomly sampled as candidates at each split (mtry = 36). The confusion matrix, a
performance measurement technique, associated with the RF model is also
generated, as well as the out-of- bag (OOB) error rate (%), which is a measure for
prediction error. In the folder ‘Model visualisations’, a JPG-file is generated with a
plotted decision tree representative of the random forest output. However, be aware
that these models are visually complex and often uninterpretable. To generate a more
readable friendly model for the purpose of visualisation, a depth parameter can be

specified.

tree.RGB < randomForest( Ntree = 1000 - Number of bootstrap
Material ~ ., .
data = RGB_dataset[, -1], replicates (= number of trees to grow).
ntree=1000, .
mtry = 36, The performance of a RF model will
replace=r, .
importance = T, plateau beyond a certain number of
keep.forest=T,

keep.inbag=T, trees. For more information, run the
do. trace=50

)

print(tree.RGB)

script under ‘#Model information’.
Mtry = 36 — Number of variables

randomly sampled as candidates for

jpeg(file = "PDM_visuali
plot.getTree(tree.RGB)
dev.off()

splitting at each node.

Figure 10: RF model specifications in the script

C. A 5-fold cross-validation can be performed to validate the performance of the

generated model under ‘#K-fold cross validation’.

D. To determine the required number of bootstrap trees for accurate results (= as a
function of model prediction error), as well as the required minimum training panel
size and the required minimum number of parameters, run script under ‘#Model

information’.
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8.3.4. Microplastic Analysis using Generated Models

To analyse particles of unknown origin within a sample, a RGB dataset of the particles is
needed. To create this new dataset, follow the same steps as done to build the model

training dataset(s).

A. First, create a new subfolder within ‘Automated MP_analysis' called '"MP analyses’.
Create subfolders in the same way as done for the model construction (‘Photos’,
'Metadata’, and 'RGB'). Use PTFE filter-specific folders if batch mode is not used.

B. Create a RGB dataset in the same manner as done before, this time of unknown
particles photographed after sample extraction and staining with Nile red. In the
dataset, replace the content in the column ‘Material’ by ‘Unknown’. Give the dataset an
appropriate name, e.g. 'sample1_RGBdataset.xlsx'.

C. Openthe code 'PDM_PIM"in R.

e Under #Generate model’, make sure the first working directory is again set to

where the model training datasets are stored: setwd(".../Model_constructions
/Training_datasets”), Create a read_excel()-function for this dataset: RGB_dataset
<- read_excel("PDM_RGBdataset.xlsx”).

e Under#Model prediction, adapt the working directory to the directory where the

RGB dataset created from the analysed sample is stored, e.g.
setwd(".../Analyses/sample1/RGB/UV"). Create another read_excel()- function for
the generated dataset of unknown particles:

Unknown_dataset <- read_excel("sample 1_RGBdataset.xIsx").

e Chose a name for the Excel file with particle predictions which will be generated
when running this code. It is advised to use the name of the dataset, and to add
'_MP_predictions’, followed by the model used to perform the predictions, e.g.
"sample1_RGBdataset_ MP_predictions_PDM’ xIsx"

Filename<- paste(Date," sample1_RGBdataset_ MP_predictions_PDM’xlsx.",sep=

n u)

D. Run the complete code. Following this, an Excel file will be generated with model
predictions on the plastic or non- plastic identity of the unknown particles, in case the
PDM dataset is being used. If the PIM dataset is used, predictions of polymer types will

be generated for these particles (see Figure 11).
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Particle_number Material Predicted Material
1 UNKNOWN PLASTIC
2 UNKNOWN PLASTIC

3 UNKNOWN PLASTIC Particle_number Material Predicted Material
4 UNKNOWN ORGANIC 1 UNKNOWN PET

5 UNKNOWN ORGANIC 2 UNKNOWN PET

6 UNKNOWN ORGANIC 3 UNKNOWN PVC

7 UNKNOWN ORGANIC 9 UNKNOWN PS

8 UNKNOWN ORGANIC
9 UNKNOWN PLASTIC
10 UNKNOWN ORGANIC
11 UNKNOWN ORGANIC
12 UNKNOWN ORGANIC

Figure 11: Particle identity predictions from PDM (left) and PIM (right) of an unknown
sample dataset.
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